
Introduction

This chapter provides information about Cisco Unified Communications Manager (formerly Cisco Unified
CallManager).

• About Cisco Unified Communications Manager, on page 1
• Key Features and Benefits , on page 2
• Cisco Unified Communications Manager Administration Web Browsers , on page 2
• Cisco Unified Communications Manager Administration Application , on page 12
• Accessibility, on page 19
• Where to Find More Information , on page 20

About Cisco Unified Communications Manager
Cisco Unified CommunicationsManager (formerly Cisco Unified CallManager) serves as the software-based
call-processing component of the Cisco Unified Communications family of products. In Release 10.0(1) and
later, Cisco only supports virtualized deployments of Cisco Unified Communications Manager (Unified
Communications Manager) on Cisco Unified Computing System servers, or on a Cisco-approved third-party
server configuration. In Release 10.0(1) and later, Cisco does not support deployments of Unified
Communications Manager on Cisco Media Convergence Server servers.

For more information about the deployment of Unified CommunicationsManager in a virtualized environment,
see:

http://docwiki.cisco.com/wiki/Unified_Communications_in_a_Virtualized_Environment.

The Cisco Unified Communications Manager system extends enterprise telephony features and functions to
packet telephony network devices such as IP phones, media processing devices, voice-over-IP (VoIP) gateways,
andmultimedia applications. Additional data, voice, and video services, such as unified messaging, multimedia
conferencing, collaborative contact centers, and interactive multimedia response systems, interact through
Cisco Unified Communications Manager open telephony application programming interface (API).

Cisco Unified Communications Manager provides signaling and call control services to Cisco integrated
telephony applications as well as third-party applications. Cisco Unified Communications Manager performs
the following primary functions:

• Call processing

• Signaling and device control

• Dial plan administration
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• Phone feature administration

• Directory services

• Operations, administration, maintenance, and provisioning (OAM&P)

• Programming interface to external voice-processing applications such as Cisco IP Communicator, Cisco
Unified IP Interactive Voice Response (IP IVR).

Key Features and Benefits
The Cisco Unified Communications Manager system includes a suite of integrated voice applications that
perform voice-conferencing and manual attendant console functions. This suite of voice applications means
that no need exists for special-purpose voice-processing hardware. Supplementary and enhanced services
such as hold, transfer, forward, conference, multiple line appearances, automatic route selection, speed dial,
last-number redial, and other features extend to IP phones and gateways. Because Cisco Unified
Communications Manager is a software application, enhancing its capabilities in production environments
requires only upgrading software on the server platform, thereby avoiding expensive hardware upgrade costs.

Distribution of Cisco Unified Communications Manager and all Cisco Unified IP Phones, gateways, and
applications across an IP network provides a distributed, virtual telephony network. This architecture improves
system availability and scalability. Call admission control ensures that voice quality of service (QoS) is
maintained across constrictedWAN link and automatically diverts calls to alternate public switched telephone
network (PSTN) routes when WAN bandwidth is not available.

A web-browsable interface to the configuration database provides the capability for remote device and system
configuration. This interface also provides access to HTML-based online help for users and administrators.

Cisco Unified CommunicationsManager, designed to work like an appliance, refers to the following functions:

• Cisco Unified CommunicationsManager servers can get preinstalled with software to ease customer and
partner deployment and automatically search for updates and notify administrators when key security
fixes and software upgrades are available for their system.This process comprises Electronic Software
Upgrade Notification.

• You can upgrade Cisco Unified Communications Manager servers while they continue to process calls,
so upgrades take place with minimal downtime.

• Cisco Unified Communications Manager supports the Asian and Middle Eastern markets by providing
support for Unicode on higher resolution phone displays.

• Cisco Unified Communications Manager provides Fault, Configuration, Accounting, Performance, and
Security (FCAPS).

Cisco Unified Communications Manager Administration Web
Browsers

You access the Cisco Unified Communications Manager Administration program from a PC that is not the
web server or has Cisco Unified CommunicationsManager installed. No browser software exists on the server.
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Web Browser Support
Cisco Unified Communications Manager Administration supports the following operating system browsers:

• On Microsoft Windows XP, Vista, and 7:

• Microsoft Internet Explorer (IE) 8, IE 9

• Mozilla Firefox 4.x, Firefox 10.x

• Google Chrome 8.x (only Self Care Portal page)

• On Apple OS X and later:

• Apple Safari 5.x

• Firefox 4.x, 10.x

• Google Chrome 8.x (only Self Care Portal page)

From any user PC in your network, browse into a server that is running Cisco Unified Communications
Manager Administration and log in with administrative privileges.

Simultaneous login to Cisco Unified Communications Manager Administration by a large number of users
can cause performance to suffer. Try to limit the number of users and administrators that are logged on
simultaneously.

Note

Cisco Unified Communications Manager Administration does not support the buttons in your browser. Do
not use the browser buttons (for example, the Back button) when you perform configuration tasks.

Note

If you receive the following error message upon saving a configuration, entered changes are not lost. Click
Save again after seeing the error message.

Note

Security Error : The attempted action was a violation of security protocols and will not be allowed. This may
be caused by having multiple concurrent windows open or using browser buttons (back, refresh, etc). Please
retry the operation

Log In to Cisco Unified CM Administration
Use the following procedure to log in to Cisco Unified Communications Manager Administration. After you
log in to Cisco Unified Communications Manager Administration, messages may display that indicate the
current state of licenses for Cisco Unified CommunicationsManager in the main window. For example, Cisco
Unified Communications Manager may identify the following situations:

• Cisco Unified Communications Manager currently operates with starter (demo) licenses, so upload the
appropriate license files.
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• Cisco Unified Communications Manager currently operates with an insufficient number of licenses, so
upload additional license files.

• Cisco Unified Communications Manager does not currently use the correct software feature license. In
this case, the Cisco CallManager service stops and does not start until you upload the appropriate software
version license and restart the Cisco CallManager service.

Use the following procedure to browse into the server and log in to Cisco Unified Communications Manager
Administration.

Procedure

Step 1 Start your preferred operating system browser.
Step 2 In the address bar of the web browser, enter the following case-sensitive URL:

https://<Unified CM-server-name>:{8443}/ccmadmin/showHome.do

where: <Unified CM-server-name> equals the name or IP address of the server

You can optionally specify a port number.Note

Step 3 A Security Alert dialog box displays. Click the appropriate button.
Step 4 At themain CiscoUnified CommunicationsManager Administrationwindow, enter the username and password

that you specified during Cisco Unified Communications Manager installation and click Login. (If you want
to clear the content of both fields, click Reset.)

For security purposes, Cisco Unified Communications Manager Administration logs you out after
30 minutes of inactivity, and you must log back in.

Note

Log Out of Cisco Unified Communications Manager Administration
Use the following procedure to log out of Cisco Unified Communications Manager Administration.

Procedure

Step 1 From the main Cisco Unified Communications Manager Administration window, click the Logout link in the
upper, right corner.

Step 2 The window redisplays with the login fields.

Hypertext Transfer Protocol Over Secure Sockets Layer (HTTPS) Support
HTTPS, or Hypertext Transfer Protocol over Secure Sockets Layer (SSL), secures communication between
a browser and a web server for Microsoft Windows users. HTTPS uses certificates to ensure server identities
and to secure the browser connection. HTTPS uses a public key to encrypt the data, including the user login
and password, during transport over the Internet.
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To enable HTTPS, you must download a certificate that identifies the server during the connection process.
You can accept the server certificate for the current session only, or you can download the certificate to a trust
folder (file) to secure the current session and future sessions with that server. The trust folder stores the
certificates for all your trusted sites.

The following Cisco Unified Communications Manager applications support HTTPS:

• Cisco Unified Communications Manager Administration
• Cisco Unity Connection Administration
• Cisco Unified Serviceability
• Cisco Unified Communications Self Care Portal
• Trace Collection Tool
• Cisco Unified Real Time Monitoring Tool (Unified RTMT)
• The XML (AXL) application programming interface

A self-signed certificate gets generated on the web server at installation (the certificate also gets migrated
during upgrades).

Web Interface Timeout
Using the Command Line Interface (CLI), you can configure time, in minutes, after which the web interface
times out and logs off the user. The default timeout value is 30minutes. For more information, see theCommand
Line Interface Reference Guide for Cisco Unifed Communications Solutions.

Import Cisco Certificate for Internet Explorer 7
Internet Explorer (IE) 7 adds security features that change the way that the browser handles Cisco certificates
for website access. Because Cisco provides a self-signed certificate for the Cisco Unified Communications
Manager server, Internet Explorer 7 flags the Cisco Unified CommunicationsManager Administration website
as untrusted and provides a certificate error, even when the trust store contains the server certificate.

Cisco Unified Communications Manager Administration supports IE 7 when it is running on Microsoft
Windows XP SP3.

Note

Be sure to import the Cisco Unified Communications Manager certificate to Internet Explorer 7 to secure
access without having to reload the certificate every time that you restart the browser. If you continue to a
website that has a certificate warning and the certificate is not in the trust store, Internet Explorer 7 remembers
the certificate for the current session only.

After you download the server certificate, Internet Explorer 7 continues to display certificate errors for the
website. You can ignore the security warnings when the Trusted Root Certificate Authority trust store for the
browser contains the imported certificate.

The following procedure describes how to import the Cisco Unified Communications Manager certificate to
the root certificate trust store for Internet Explorer 7.
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Procedure

Step 1 Browse to the application on the Tomcat server (for example, enter the hostname, localhost, or IP address for
Cisco Unified Communications Manager Administration in the browser).

The browser displays a Certificate Error: Navigation Blocked page to indicate this website is untrusted.

Step 2 Click Continue to this website (not recommended) to access the server.

The Cisco Unified Communications Manager Administration window displays, and the browser displays the
address bar and Certificate Error status in red.

Step 3 To import the server certificate, click the Certificate Error status box to display the status report. Click the
View Certificates link in the report.

Step 4 Verify the certificate details.

The Certification Path tab displays “This CA Root certificate is not trusted because it is not in the Trusted
Root Certification Authorities store.”

Step 5 Select the General tab in the Certificate window and click Install Certificate.

The Certificate Import Wizard launches.

Step 6 To start the Wizard, click Next.

The Certificate Store window displays.

Step 7 Verify that the Automatic option, which allows the wizard to select the certificate store for this certificate
type, is selected and click Next.

Step 8 Verify the setting and click Finish.

A security warning displays for the import operation.

Step 9 To install the certificate, click Yes.

The Import Wizard displays “The import was successful.”

Step 10 Click OK. The next time that you click the View certificates link, the Certification Path tab in the Certificate
window displays “This certificate is OK.”

Step 11 To verify that the trust store contains the imported certificate, click Tools > Internet Options in the Internet
Explorer toolbar and select the Content tab. Click Certificates and select the Trusted Root Certifications
Authorities tab. Scroll to find the imported certificate in the list.

After importing the certificate, the browser continues to display the address bar and a Certificate Error status
in red. The status persists even if you reenter the hostname, localhost, or IP address or refresh or relaunch the
browser.

What to do next

You can copy the certificate to a file and store it locally so that you can restore the certificate whenever
necessary.
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Import Cisco Certificate for Internet Explorer 8

Cisco Unified Communications Manager Administration supports IE 8 when it is running on Microsoft
Windows XP SP3 or Microsoft Vista SP2.

Note

Be sure to import the Cisco Unified Communications Manager certificate to Internet Explorer 8 to secure
access without having to reload the certificate every time that you restart the browser. If you continue to a
website that has a certificate warning and the certificate is not in the trust store, Internet Explorer 8 remembers
the certificate for the current session only.

After you download the server certificate, Internet Explorer 8 continues to display certificate errors for the
website. You can ignore the security warnings when the Trusted Root Certificate Authority trust store for the
browser contains the imported certificate.

The following procedure describes how to import the Cisco Unified Communications Manager certificate to
the root certificate trust store for Internet Explorer 8.

Procedure

Step 1 Browse to application on the Tomcat server (for example, enter the hostname, localhost, or IP address for
Cisco Unified Communications Manager Administration in the browser).

The browser displays a Certificate Error: Navigation Blockedmessage to indicate that this website is untrusted.

Step 2 Click Continue to this website (not recommended) to access the server.

The Cisco Unified Communications Manager Administration window displays, and the browser displays the
address bar and Certificate Error status in red.

Step 3 To import the server certificate, click the Certificate Error status box to display the status report. Click the
View Certificates link in the report.

Step 4 Verify the certificate details.
Step 5 Select the General tab in the Certificate window and click Install Certificate.

The Certificate Import Wizard launches.

Step 6 To start the Wizard, click Next.

The Certificate Store window displays.

Step 7 Verify that the Automatic option, which allows the wizard to select the certificate store for this certificate
type, is selected and click Next.

Step 8 Verify the setting and click Finish.

A security warning displays for the import operation.

Step 9 To install the certificate, click Yes.

The Import Wizard displays “The import was successful.”

Step 10 ClickOK. The next time that you click the View certificates link, theCertification Path tab in the Certificate
window displays “This certificate is OK.”
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Step 11 To verify that the trust store contains the imported certificate, click Tools > Internet Options in the Internet
Explorer toolbar and select the Content tab. Click Certificates and select the Trusted Root Certifications
Authorities tab. Scroll to find the imported certificate in the list.

After importing the certificate, the browser continues to display the address bar and a Certificate Error status
in red. The status persists even if you reenter the hostname, localhost, or IP address or refresh or relaunch the
browser.

What to do next

You can copy the certificate to a file and store it locally so that you can restore the certificate whenever
necessary.

Import Cisco Certificate for FireFox 3.x

Cisco Unified CommunicationsManager Administration supports FireFox 3.x when it is running onMicrosoft
Windows XP SP3, Microsoft Vista SP2 or Apple MAC OS X.

Note

The first time that you (or a user) accesses Cisco Unified Communications Manager Administration or other
Cisco Unified Communications Manager SSL-enabled virtual directories (after the Cisco Unified
CommunicationsManager installation/upgrade) from a browser client, a Security Alert dialog box asks whether
you trust the server.

When the dialog box displays, you must perform one of the following tasks:

• By clicking I Understand The Risks, you choose to trust the certificate for the current web session only.
If you trust the certificate for the current session only, the Security Alert dialog box displays each time
that you access the application; that is, until you install the certificate in the trusted folder.

• By clicking Get Me Out Of Here, you cancel the action. No authentication occurs, and you cannot
access the web application. To access the web application, you must click I Understand The Risks.

The following procedure describes how to import the Cisco Unified Communications Manager certificate to
the root certificate trust store for FireFox 3.x.

Procedure

Step 1 Access the Tomcat server (for example, enter the hostname, localhost, or IP address for Cisco Unified
Communications Manager Administration in the browser).

Step 2 When the Security Alert dialog box displays, click I Understand The Risks.
Step 3 Click Add Exception.

The Add Exception dialog box displays.

Step 4 Click Get Certificate.
Step 5 Check the Permanently store this exception check box.
Step 6 Click Confirm Security Exception.
Step 7 To view the details of the certificate by performing the following steps:
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a) From the FireFox browser, click Tools > Options.

The Options dialog box displays

b) Click Advanced.
c) Click View Certificates.

The Certificate Manager dialog box displays.

d) Highlight the certificate that you want to view and click View.

The Certificate Viewer dialog box displays.

e) Click the Details tab.
f) In the Certificate Fields field, highlight the field that you want to view.

Details display in the Field Values field.

g) From the Certificate Viewer dialog box, click Close.
h) From the Certificate Manager dialog box, click OK.

Import Cisco Certificate for Safari 4.x

Cisco Unified Communications Manager Administration supports Safari 4.x when it is running on Apple
MAC OS X.

Note

The first time that you (or a user) accesses Cisco Unified Communications Manager Administration or other
Cisco Unified Communications Manager SSL-enabled virtual directories (after the Cisco Unified
CommunicationsManager installation/upgrade) from a browser client, a Security Alert dialog box asks whether
you trust the server.

When the dialog box displays, you must perform one of the following tasks:

• By clicking Yes, you choose to trust the certificate for the current web session only. If you trust the
certificate for the current session only, the Security Alert dialog box displays each time that you access
the application; that is, until you install the certificate in the trusted folder.

• By clicking Show Certificate > Install Certificate, you intend to perform certificate installation tasks,
so you always trust the certificate. If you install the certificate in the trusted folder, the Security Alert
dialog box does not display each time that you access the web application.

• By clicking No, you cancel the action. No authentication occurs, and you cannot access the web
application. To access the web application, you must click Yes or install the certificate via the Show
Certificate > Install Certificate options.

The address that you use to access Cisco Unified CommunicationsManager must
match the name on the certificate or a message will appear by default. If you
access the web application by using the localhost or IP address after you install
the certificate in the trusted folder, a security alert indicates that the name of the
security certificate does not match the name of the site that you are accessing.

Note
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The following procedure describes how to import the Cisco Unified Communications Manager certificate to
the root certificate trust store for Safari 4.x.

Procedure

Step 1 Access the Tomcat server (for example, enter the hostname, localhost, or IP address for Cisco Unified
Communications Manager Administration in the browser).

Step 2 When the Security Alert dialog box displays, click Show Certificate.

You can click the Details tab to view the details of the certificate if you choose to verify the certificate data.
To display a subset of settings, if available, choose one of the following options:

a) All—All options display in the Details pane.
b) Version 1 Fields Only—Version, Serial Number, Signature Algorithm, Issuer, Valid From, Valid To,

Subject, and the Public Key options display.
c) Extensions Only—Subject Key Identifier, Key Usage, and the Enhanced Key Usage options display.
d) Critical Extensions Only—Critical Extensions, if any, display
e) Properties Only—Thumbprint algorithm and the thumbprint options display.

Step 3 In the Certificate pane, click Install Certificate.
Step 4 When the Certificate Import Wizard displays, click Next.
Step 5 Click the Place all certificates in the following store radio button; click Browse.
Step 6 Browse to Trusted Root Certification Authorities; select it and click OK.
Step 7 Click Next.
Step 8 Click Finish.

A Security Warning Box displays the certificate thumbprint for you.

Step 9 To install the certificate, click Yes.

A message states that the import was successful. Click OK.

Step 10 In the lower, right corner of the dialog box, click OK.
Step 11 To trust the certificate, so you do not receive the dialog box again, click Yes.

You can verify the certificate was installed successfully by clicking the Certification Path tab in the
Certificate pane.

Tip

What to do next

You can copy the certificate to a file and store it locally so that you can restore the certificate whenever
necessary.

Copy Web Browser Certificates to File
You can copy certificates to local files and restore the certificates later whenever necessary.

Performing the following procedure copies the certificate using a standard certificate storage format for the
following browsers:
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• Internet Explorer 7

• Internet Explorer 8

• Safari 4.x

Procedure

Step 1 View the certificate.
a) For Internet Explorer, click the Certificate Error status box, then click View Certificates.
b) For Safari 4.x, click Show Certificate in the Security Alert dialog box.

In Safari, click the Certificate Error status box to display the Show Certificate option.Tip

Step 2 Click the Details tab.
Step 3 Click the Copy to File button.
Step 4 The Certificate Export Wizard displays. Click Next.
Step 5 The following list defines the file formats from which you can choose. Choose the file format that you want

to use for the exported file; click Next.
a) DER encoded binary X.509 (.CER)—Uses DER to transfer information between entities.
b) Base-64 encoded X.509 (.CER)—Sends secure binary attachments over the internet; uses ASCII text

format to prevent corruption of file.
c) Cryptographic Message Syntax Standard-PKCS #7 Certificates (.P7B)—Exports the certificate and all

certificates in the certification path to the chosen PC.

Step 6 Browse to the location to which you want to export the file copy and name the file. Click Save.
Step 7 The file name and path display in the Certificate Export Wizard pane. Click Next.
Step 8 Your file and settings display. Click Finish.
Step 9 When the successful export dialog box displays, click OK.

Copy FireFox Certificate to File
You can copy the certificate to a local file and restore the certificate later whenever necessary.

Performing the following procedure copies the certificate by using a standard certificate storage format. To
copy the certificate contents to file, perform the following procedure.

Procedure

Step 1 From the FireFox browser, click Tools > Options.

The Options dialog box displays.

Step 2 If it is not already selected, click Advanced.
Step 3 Click the Encryption tab and click View Certificates.

The Certificate Manager dialog box displays.
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Step 4 Click the Servers tab.
Step 5 Highlight the certificate you want to copy and click Export.

The Save Certificate to File dialog box displays.

Step 6 Browse to the location to which you want to copy the file.
Step 7 From the Save as type drop-down list, choose the file type from the following options:

a) X.509 Certificate (PEM)—Uses PEM to transfer information between entities.
b) X.509 Certificate with chain (PEM)—Uses Privacy Enhanced Mail to verify the certificate chain and

transfer information between entities.

• X.509 Certificate (DER)—Uses DER to transfer information between entities.

• X.509 Certificate (PKCS#7)—PKCS#7 is a standard for signing or encrypting data. Since the
certificate is needed to verify signed data, it is possible to include it in the SignedData structure.
A .P7C-file is just a degenerated SignedData structure, without any data to sign.

• X.509 Certificate with chain (PKCS#7)—Uses PKCS#7 to verify the certificate chain and transfer
information between entities.

Step 8 Click Save.
Step 9 Click OK.

What to do next

You can copy the certificate to a file and store it locally so that you can restore the certificate whenever
necessary.

Cisco Unified Communications Manager Administration
Application

You use Cisco Unified Communications Manager Administration, a web-based application, to perform
configuration tasks for Cisco Unified CommunicationsManager servers. This section describes basic elements
of the graphical user interface, including the navigation menus and the documentation search feature that
allows you to search Cisco Unified Communications Manager documentation on Cisco.com.

Cisco Unified Communications Manager Administration Graphical User
Interface

After you log in, the main Cisco Unified Communications Manager Administration window redisplays. The
window includes the drop-down list box in the upper, right corner called Navigation. To access the applications
in the drop-down list box, choose the program that you want and click Go.

The minimum supported screen resolution specifies 1024x768. Devices with lower screen resolutions may
not display the applications correctly.

Note
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Navigation Drop-Down List Box
The choices in the Navigation drop-down list box include the following Cisco Unified Communications
Manager applications:

• Cisco Unified Communications Manager Administration—Shows as default when you access Cisco
Unified Communications Manager. Use Cisco Unified Communications Manager Administration to
configure system parameters, route plans, devices, and much more.

• Cisco Unified Serviceability—Takes you to the main Cisco Unified Serviceability window that is used
to configure trace files and alarms and to activate and deactivate services.

• Cisco Unified OS Administration—Takes you to the main Cisco Unified OS Administration window,
so you can configure and administer the Cisco Unified Communications Manager platform. You must
log out from any other application before you can log in to this application.

• Disaster Recovery System—Takes you to the Cisco Disaster Recovery System, a program that provides
full data backup and restore capabilities for all servers in a Cisco Unified Communications Manager
cluster. You must log out from any other application before you can log in to this application.

• Cisco Unified Reporting—Takes you to the main Cisco Unified Reporting window where you can
generate system reports.

Links to Search documentation, About, and Logout
The following links display on the main Cisco Unified Communications Manager Administration window
directly below the Navigation drop-down list box:

• Search Documentation—Click this link to search Cisco Unified CommunicationsManager documentation
on Cisco.com for the current release. The Cisco Unified CM Documentation Search window displays.
Type the word or words for which you want to search and click the Search button. The search results
display. You can narrow the search results by choosing a documentation type modifier button that displays
above your search result; for example, Unified CM Install/Upgrade or Unified CM Release Notes.

• About—Click this link to display the Cisco Unified Communications Manager Administration main
window where you can view the system software version.

• Logout—Click this link to log out of the Cisco Unified Communications Manager Administration
application. The window redisplays with the login fields.

Menu Bar
The horizontal bar located across the top of the interface contains the names of the menus. Click the menu
options to display the Cisco Unified Communications Manager Administration windows. Menu items in this
document appear in boldface font. A > (greater than) symbol separates menu item selections. In the browser,
this indicates a menu item selection; for example: Choose Advanced Features > Intercompany Media
Services > Service.

Shared Login
After you log in to Cisco Unified Communications Manager Administration, you can access all applications
that display in the Navigation drop-down list box, except the Cisco Unified Operating System Administration
and Disaster Recovery System, without needing to log in to each application. You cannot access the Cisco
Unified Operating System Administration or Disaster Recovery System GUIs with the same username and
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password that you use to access Cisco Unified Communications Manager Administration. To access these
applications from Cisco Unified Communications Manager Administration, you must first click the Logout
link in the upper, right corner of the Cisco Unified Communications Manager Administration window; then,
choose the application from the Navigation drop-down list box and click Go.

If you have already logged in to one of the applications that display in the Navigation drop-down list box
(other than Cisco Unified Operating System Administration or Disaster Recovery System), you can access
Cisco Unified CommunicationsManager Administration without logging in. From the Navigation drop-down
list box, choose Cisco Unified Communications Manager Administration and click Go.

Cisco Unified Communications Manager Administration Help
To access Help, click the Help menu in the Cisco Unified CommunicationsManager Administration navigation
menu, and choose one of the following options:

• Contents—Opens a new browser window and displays the home page for the Cisco Unified
Communications Manager Administration Help system. The links in the left pane of the Help window
allow you to access all topics in the Help system.

• This Page—Opens a new browser window for the CiscoUnified CommunicationsManager Administration
Help system. The right pane of the window contains definitions for each field in the current window in
CiscoUnified CommunicationsManager Administration. Inmost cases, cross-references point to additional
topics that relate to the current window.

• About—Displays the Cisco Unified Communications Manager Administration main window where you
can view the system software version.

The left pane of the Help system provides a table of contents for all of the product guides that the Help system
includes. The table of contents expands to show the location within the hierarchy of the Help topic that displays
on the right.

To learnmore about the Cisco Unified CommunicationsManager Administration system, including instructions
on how to search Help, click the Using Help link at the top of any Help window.

Find and Delete Records
You can search Cisco Unified Communications Manager for any records that you have added to the database
through the Cisco Unified Communications Manager Administration windows or for records that exist as
default entries. To find records, you navigate to the Find and List window for the record that you want to
locate, such as Find and List Phones (Device > Phone). You can search for all records or enter search criteria
to narrow your search. The search parameters vary, depending on the records for which you are searching.
For example, when searching for a phone, you can search for phones with certain digits in the directory number
or certain characters in the device name. When searching for an end user, you can search for first names or
last names that contain certain letters.

Once you have found records, you can delete them from the Find and List window that contains your records.
You can delete individual records or delete all records that display in the window.

During your work in a browser session, the cookies on the client machine store your find/list search preferences.
If you navigate to other menu items and return to this menu item, or if you close the browser and then reopen
a new browser window, your Cisco Unified Communications Manager search preferences get retained until
you modify your search.

Note
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Use the following procedure to find or delete records from Cisco Unified Communications Manager
Administration.

Procedure

Step 1 Navigate to the Find and List window in Cisco Unified Communications Manager Administration for the
component that you want to find. For example, if you want to find a phone, chooseDevice > Phone to display
the Find and List Phones window.

Step 2 To find all records in the database, ensure the dialog box is empty.
Step 3 To filter or search records

a) From the first drop-down list box, select a search parameter. The search parameter represents the field on
which you want to search. The search parameters vary, depending on the records type.

b) From the second drop-down list box, select a search pattern. The search pattern defines how the system
searches the records. For example, you might want to search for records (or search parameters) that contain
a certain value that you specify in the search text field.

c) Specify the appropriate search text, if applicable. The search text allows you to specify values for which
you want to search. Use this field in conjunction with the search parameter and search pattern fields. For
example, if you choose “Directory Number” from the search parameter drop-down list box, choose
“contains” from the search pattern drop-down list box, and enter 5551212 as the search text, the system
searches for a directory number that contains the digits 5551212.

To add additional search criteria, click the + button. When you add criteria, the system searches
for a record that matches all criteria that you specify. To remove criteria, click the – button to
remove the last added criterion or click the Clear Filter button to remove all added search
criteria.

Note

Step 4 Click Find.

All matching records display.

You can change the number of items that display on each page by choosing a different value from the Rows
per Page drop-down list box.

You can reverse the sort order, by clicking the Up Arrow or Down Arrow, if available, in the list header.

You can delete multiple records from the database by checking the check boxes next to the appropriate
record(s) and clicking Delete Selected. You can delete all configurable records for this selection
by clicking the check box at the top of the column of check boxes and then clickingDelete Selected.

Note

Step 5 From the list of records that display, click the link for the record that you want to view.

The window displays the item that you choose.

Add and Copy Records
You can add items to the Cisco Unified Communications Manager by creating new records in Cisco Unified
Communications Manager Administration and sometimes by copying existing records. Use the following
procedure to add or copy records to the database.
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Procedure

Step 1 Navigate to the Find and List window in Cisco Unified Communications Manager Administration for the
component that you want to add or copy. For example, if you want to add a transcoder, chooseMedia
Resources > Transcoder to display the Find and List Transcoders window.

Step 2 To add a new record, click the Add New button.

The window refreshes with a new record. Make the necessary changes, and click Save.

Step 3 To copy an existing record, do one of the following:
a) Use the Find and List window to display a set of records. From the list of records, click the Copy icon

for a particular record, if the icon is available.
b) Locate the record that you want to copy. Choose the record, which causes the complete record to display.

Click theCopy icon in the configuration window. For example, find the transcoder that you want to copy,
and click the Copy icon in the Transcoder Configuration window.

The window refreshes with a new record. Make the necessary changes, and click Save.

You must make a change to the copied record before you save the copy. If you do not, the
system does not save the copy.

Note

Step 4 To copy an existing record and populate a new record with all of the associated information from the existing
record:
a) Use the Find and List window to display a set of records. From the list of records, click the Super Copy

icon for a particular record, if the icon is available.
b) Locate the record that you want to copy. Choose the record, which causes the complete record to display.

Click the Super Copy button in the configuration window. For example, find the phone record that you
want to copy, and click the Super Copy button in the Phone Configuration window.

The window refreshes with a new Device Name field. Make the necessary changes, and click Save.

GUI Buttons and Icons
The Cisco Unified CommunicationsManager Administration windows use a common set of buttons and icons
across the GUI. In general, icons display in a row that follows the window name, and a matching set of buttons
displays near the bottom of the window.

Not all buttons and icons display on all windows. For those buttons that are not listed here, the individual
configuration settings tables for each record type describe buttons that pertain to particular record types.

Note

The Cisco Unified Communications Manager Administration GUI has the following groups of buttons and
icons:

• Buttons and Icons on Find and List Windows

• Buttons and Icons on Configuration Windows
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Find and List Window Buttons and Icons
The following icons and buttons are found in the Find and List windows of the Cisco Unified Communications
Manager Administration GUI:

• Add New—Opens a blank window of the same record type. Add configuration details to the new record
and click Save, or choose an option in the Related Links drop-down list box.

• Select All—Chooses all of the records of a particular type that you are displaying. The check boxes to
the left of each record get checked.

This button selects only the records on the particular page that you are displaying.Note

Example: Your search for partitions yielded 300 partitions, but you are only
displaying 50 rows per page. If you click Select All while displaying any set of
50 partitions, only those 50 partitions get checked.

Note

• Clear All—Deselects all of the records of a particular type that you are displaying. The check boxes to
the left of each record get unchecked.

• Delete Selected—After you display a set of records, deletes the records for which you have checked the
check boxes at left. You must confirm the deletion before the deletion takes place.

• Reset Selected—After you display a set of records, resets the records for which you have checked the
check boxes at left. A popup window opens and offers the following choices:

• Reset—Shuts down the device(s) and then restarts it (them).

• Restart—Restarts the device(s) without shutting it (them) down.

• Close—Closes the popup window without taking any action.

• Apply Config to Selected—When you change the configuration settings of a record, you may receive a
message that directs you to click the Apply Config button to have the changes take effect. You can wait
until you finish configuring multiple devices, then return to the Find and List window. Select the
reconfigured devices and click the Apply Config to Selected button. A popup window advises of the
possible actions that will take place when you click OK.

• To add additional search criteria, click the + button. When you add criteria, the system searches for a
record that matches all criteria that you specify. To remove criteria, click the – button to remove the last
added criterion or click the Clear Filter button to remove all added search criteria.

• Find—Initiates a search for all records that match the criteria that you entered.

• Clear Filter—Removes all added search criteria from a search.

• + (Plus button)—To add additional search criteria to a search, click the + button. When you add criteria,
the system searches for a record that matches all criteria that you specify.

• – (Minus button)—To remove criteria from a search, click the – button to remove the last added criterion.
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• First-page Arrow—In a multipage list of records, click the First-page Arrow to display the first page of
records.

• Left Arrow—In a multipage list of records, click the Left Arrow to display the preceding page of records.

• Right Arrow—In a multipage list of records, click the Right Arrow to display the following page of
records.

• Last-page Arrow—In a multipage list of records, click the Last-page Arrow to display the last page of
records.

• Go—In a multipage list of records, enter a value for the page of records to display; then, click Go.

Configuration Windows Buttons and Icons
The following icons and buttons are found in the Configuration windows of the Cisco Unified Communications
Manager Administration GUI:

• Save—Saves the current record.

• Delete—Deletes the current record after requesting confirmation of the deletion.

• Copy—Refreshes the window with a copy of the current record. You must change at least one value
(usually, the record name) before you can save the copied record by clicking Save.

• Reset—Opens a popup window that offers the following choices:

• Reset—Shuts down the device and then restarts it.

• Restart—Restarts the device without shutting it down.

• Close—Closes the popup window without taking any action.

• Apply Config—When you change the configuration settings of a record, you may receive a message that
directs you to click the Apply Config button to have the changes take effect. When you click the Apply
Config button, a popup window advises of the possible actions that will take place when you click OK.

• Add New—Opens a blank window of the same record type. Add configuration details to the new record
and click Save, or choose an option in the Related Links drop-down list box.

• Next—For record types that require multiple steps to add a new record, the Next button takes you from
one step to the next.

Cisco Unified Presence Server Access
If you have configured a Cisco Unified Presence server, the Cisco Unified Communications Manager
Administration main window provides a link directly to the associated Cisco Unified Presence server. To
access Cisco Unified Presence Administration, click the Cisco Unified Presence address link.

Clustered Cisco Unified Presence Server Access
If you have a Cisco Unified Presence server configured as part of the Cisco Unified CommunicationsManager
cluster, the main Cisco Unified CommunicationsManager Administration window displays a link to the Cisco
Unified Presence publisher server.
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To access Cisco Unified PresenceAdministration, click the link to the Cisco Unified Presence publisher server.

Login Message Customization
You can upload a text file that contains a customized login message that displays in the main Cisco Unified
Communications Manager Administration window.

For more information and the procedure for uploading your customized login message, see the Cisco Unified
Communications Operating System Administration Guide.

Last Successful Login Message
When you log in to Cisco Unified Communications Manager Administration, the main Cisco Unified
Communications Manager Administration window displays the date and time of the last successful system
login.

When you log in to Cisco Unified Communications Manager for the first time, the system displays the last
successful login time as the current time.

Accessibility
CiscoUnified CommunicationsManager Administration and CiscoUnified Communications Self Care Portal
provide functionality for users that allows them to access buttons on the window without using a mouse. You
can perform the following procedures from any point on the window, so the user does not have to scroll or
tab through various fields.

Access Icons
Many of the windows in Cisco Unified Communications Manager include icons that display at the top of the
window; for example, an icon of a disk for Save, an icon that is a plus sign (+) for Add, and so on. To access
these icons, perform the following procedure.

Procedure

Step 1 Press Alt, press 1; then, press Tab.

The cursor will highlight the first icon from the left. To move to the next icon, press Tab again.

Step 2 Press Enter.

The system performs the function of the icon; for example, Add.
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Access Buttons
Many of the windows in Cisco Unified Communications Manager and Cisco PCA have buttons that display
at the bottom of the window; for example, a button for Save, a button for Add, and so on. To access these
buttons, perform the following procedure.

Procedure

Step 1 Press Alt, press 2, and then press Tab.

The cursor will highlight the first button from the left. To move to the next button, press Tab again.

Step 2 Press Enter.

The function of the button gets performed; for example, Save.

Where to Find More Information
• Cisco Unified Communications Manager System Guide

• Cisco Unified Communications Manager Features and Services Guide

• Cisco Unified Serviceability Administration Guide

• Cisco Unified Communications Manager CDR Analysis and Reporting Administration Guide

• Installing Cisco Unified Communications Manager

• Upgrading Cisco Unified Communications Manager

• Cisco Unified Communications Manager Security Guide

• Cisco Unified Communications Operating System Administration Guide

• Disaster Recovery System Administration Guide

• Cisco Unified Communications Solution Reference Network Design (SRND)
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